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Terms and Definitions

ARM Advanced RISC Machine
CDT C/C++ Development Tools
CMSIS Cortex Microcontroller Software Interface Standard
DK Development Kit

Eclipse Open Source IDE

JTAG Joint Test Action Group
HTML HyperText Markup Language
GNU General Public License

GDB GNU Debugger

PC Personal Computer

RD Reference Design

SvD System View Description
URL Uniform Resource Locator
SDK Software Development Kit
HDK Hardware Development Kit
References

[1] TfEclipse Project Release Notesodocumentation in Eclipse CDT (online or local_drive),
Application Note, Dialog Semiconductor.

[2] SEGGER manual (online)
[3] UM-B-060-DA1468x/DA1510x Development Kit.
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Prerequisites

O SmartSnippetsE Studio package (contact Dialog Semic

0 Dialogbs Semiconduct or(susponadfamdies DA1ASS0/581F583S MAK4AS3X,
DA14585/586, DA1468x, DA1469x) or a Dialog Reference Design (contact Dialog Semiconductor
customer support)

0 Minimum hardware requirements:

3 Windows or Linux Operating System i 1 GHz, 32-bit or 64-bit processor
3 1 GB of system memory (RAM)
2 2 GB of available disk space

0 Development Kit (Basic or Pro) for one of the supported families and accessories

0 Serial-port terminal software (for example, RealTerm)

0 A USB connection supporting USB-Serial (FTDI)

0 Unzip program

O Forlinuxonly:netstat uti |l ity is required for SmartSnippetsE T

About User Guide

Thisguidedescri bes installation process and features of
the different components that platform supports.

Smart SnippetsE Studiort Sniumpspedt swi thDKish ef 0SmaDA14580/ 538
DA1585/586, DA1468x, DA1469x families and Reference Designs for SmartBond devices.

When the term <family> SDK is used in this manual, all devices from this family are meant.
It also applies to DA1468x-based RDs (Reference Designs)

Note: Novice users can also read one of the Getting Started Guides provided for different
development kits. [DA14531 Pro kit, DA14531 Usb kit, DA14585/586 Basic kit , DA14585/586 Pro kit,
DA1468x Pro kit, DA1469x Pro kit, DA14695 Usb Kit]

Introduction

This document presents DialogSe mi conduct or software package, SmartsS

SmartSnippet s E S-frae doftveare development plgtfarin foySmar t bondE devi ces.
fully supports the DA14531, DA14580/581/583, DA1585/586, DA1468x and DA1469x family of
devices.

Note: Some of the tools (such as KEIL, GCC, and so on) might need to get installed separately since
they are not included by default.

Smart SnippetsE Studio is a framework of tools comes
CDT.

The SmartSnippet s E | Dhbard JsLinkedebmdyér éan SEGGER. Thiswmifers
standard debug capabilities such as single stepping, setting breakpoints, software download and
many more. For more details on the debugger capabilities, visit https://www.segger.com/.

All components, tools and plug-ins are taken from the internet without changes and modifications. A
subset of useful tools/plug-ins is selected by Dialog, and these are bundled with Eclipse CDT. Users
can interact with all different tools from within the Studio environment.

Availability in tools and features is directly dependent on the selected Dialog Device Family.
For the |l atest ver si on contéct DRimaSemi®nducmpcastomdt suSporu d i o
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https://www.dialog-semiconductor.com/sites/default/files/um-b-103_da14695_usb_kit_rev_1.0.pdf
https://www.segger.com/
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Supported Systems and Versions

SmartSnippetsE Studio is getting released with suppo
versions:
0 Windows
2 Win 10 64bit
0 Linux
3 Ubuntu 20.04.1 LTS
3 Ubuntu 18.04.5LTS
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1 SmartSnippetsE Installation

1.1 Freshinstall in Microsoft Windows

This section describes installation on Microsoft Windows systems for the first time.
Supported variants:

0 Windows 10 64-bit

Disk space requirements:

0 Atleast 2 GBytes of free disk space are needed to complete this installation
To proceed with installation, go through the following steps.

1. Get access to the Smar tviSitrpiogugt pagesirEhttpS:Mskppart.difddge a s e
semiconductor.com, download and unzip SDK zip-file, preferably under a subfolder of the home
user 6s dar exanple, andgr a gubdirectory of C:\ Users \ <user> ).

It is recommended that the root directory of the selected SDK or RD is selected for creating

Smart SnippetsE Studi o workspaces, so that the C pr
and libraries of the SmartSnippets SDK. Also, see the SDK release notes.

Note: It is recommended that the pathnames of the folders used for unzipping the SDK zip files,

to be as short as possible (less than 20 characters). This is important to prevent problems under

Windows due to the maximum path length restriction (260 characters for the entire path).

2. Download the latest version of SmartSnippetsE St udi o fr om pr ofFdguret websit e,

Development Tools

Date Version
Smartsnippets Studio V2.0.14 for Windows 05 28/05/2020 2074
SmartSnippets Studio V2.0.14 for Linux O5 28/05/2020 2014
UM-B-057 SmartSnippets Studio User Manual 28/05/2020 2074
SmartSnippets Studio Release Motes 28/05/2020 204
SmartSnippets Toolbox V5.0.14 for Windows OS5 28/05/2020 5014
SmartSnippets Toolbox V5.0.14 for for Linux O5 28/05/2020 5074
UM-B-083 SmartSnippets Toolbox User Manual (HTML) 28/05/2020 5004
Smart5nippets Toolbox Release Notes 28/05/2020 50714
Figurel:Smart Sni ppetsE Studio Install Link
3. RunSmartSnippetsE St udi o installer (.msi). Several of the

installed while others need to be manually downloaded and installed.

4. I'f a previous ver si on isdoundSsencar uSimstalptfirstbefofe St udi o
proceeding to installation of current version. This may take some minutes.
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Uninstall previous versions of SmartSnippets Studio

The following installations of SmartSnippets Studio have been found in your computer. Select
which you wish to uninstall.

[w2.0.2 Installation directory: C:\DiaSemi\SmartSnippetsStudio?. 0.2:

Figure 2: Optionally Uninstall Previous Version

5. Select to install recommended and latest version of SEGGER J-Link GDB server and click Next.

() Press Mext b retal recommended versan J-Link Saftwars vE.40

() Pleass spacify svisting SEGGER J-Link software instalation:

[Badk Hext Cancel

Figure 3: Segger JLink GDB Server Installation Directory

The installer will search for already installed version and will allow easily install of the recommended
version. In case that there is an already bundled version with the installer, the prompt will be shown
as in Figure 4. It is recommended to install the version which is bundled with the installer (if not
already installed) by clicking the Next button.
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®) Select one of the avalable SEGGER J-Link GO8 Server installations (min version 4.93)

C:Vrogram Fles (x85) \SEGGER \Mink_Y544f, Lo
C:\Program Files (k85 Ex Vi

() Press Next to instal recommended version J-Link Software 5,40

. Please spedfy exsting SEGGER J-Link software installation:

Figure 4: Segger JLink GDB Server Installation Directory with Bundled GDB Server

6. Sel ect the destination folder fNext. the Smart Snippet s

Destination Folderi s t he i nstallation fol der fCol Daséimafort Sni ppef
windows installation.

Irstal Dislog SmartSrippets Studio (v2.0. 10, 1442) to:

[<: Piasem’

Back || Nedt | Cancel

Figure5: Smart Sni p podnstallatios Directary

7. The SmartSnippetsE Studi o i s,doubledickthd desittop sfodcutr un t he
or run from:
Start > All programs > Dialog Semiconductor > Smart Sn
{v<Studio_version>}
Note:
0 The default Windows installati o@\DSehider for Smart Sr
0 When Windows Defender is turned ON,i t  wi | | prevent the file Smart Sni
(.msi) from automatically running, click Run Anyway when prompted
0 Administrator access is required to install SmartSnippets Studio software components
0 During the installation, the user has to click the OK button several times
0 Window hosting the OK button may be hidden behind the active window
User Manual Revision 2.0.20 13-May-2022
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1.2 Freshinstall in Linux
This section describes installation on Linux systems for first time.
Smart SnippetsE Studio has been tested under:

& Ubuntu 20.04.1 LTS (64-bit x86_64)
O Ubuntu 18.04.5 LTS (64-bit x86_64)

Note: Smart SnippetsE St thdmostmedero 64+bid Linuxadistibutiaris.t h
Disk space requirements:

0 Atleast 2 GB of free disk space are needed to complete this installation

To proceed with installation, go through the following steps:

1. Families DA1468x and DA1469x need the netstat  utility for communication with JTAG interface.
On Ubuntu install with:

sudoapt - getinstall net - tools
2. To be able to compile native projects from the SDK on Linux, install the gcc compiler and the
make utility. On Ubuntu install with: sudoapt - getinstall buid - essential

3. SDK 1 requires GNU cross arm compiler 4.9-2015 which is a 32 bit package. To be able to run a
32 bit program on Ubuntu 64 the following packages need to be installed:
sudoapt - getinstall libc6:i386 libncursess:i386 libstdc++6:386

4. Segger SystemView 2.xx referred by current SDK require libgtgui4 . On Ubuntu 18.04 install with:
sudoapt - getinstall lbgtgui4
SystemView 2.xx is not supported on Ubuntu 20.04. User is advisable to install its own version 3.xx
from https://www.segger.com/downloads/systemview/. See also <troubleshooting> section.

5. The SmartSnippetsE SDK sources should be installed in
permi ssions to the user working with SmartSni
source files and the temporary files created during compilation/linking.

6. If a python project uses tkinter module, needs tcl/tk to be installed or else a missing library error
occurs (see Troubleshooting section). There are two ways to resolve this issue:
a. Install Tcl/Tk on the system:
i.  For Ubuntu
sudoapt - getinstall tk tcl

b. Downl oad and inst al | hths/twvwastBdstate.com/dctvetdl/doenioads) E
and update LD _LIBRARY_PATH to point to the lib directory (for example,
LD _LIBRARY PATH=$LD LIBRARY PATH:/opt/ActveTd  -86fib )

a

ppets

7. To get access to the SmartSnippetsE SDKs, contact

and unzip the SDK zip file, preferablyundera subf ol der of thefohome userds

example, under a subdirectory of .home/<user>/ ).

I't is recommended that this folder also becom

Studio workspaces, so that the C projects can easily reference the source code and libraries of

the SmartSnippetsE SDKs. Pleasesalso refer to
8. Run SmartSnippetsE Studio Installer that come

extension. Modify its properties to make it executable:

chmod +x  SmartSnippets_Studio - linux.gtk x84_64 - XXX XXX.run

User may run installer as root with sudo (for example, sudo ./SmartSnippets_Studio-
linux.gtk.x84_64-X.X.X.XXX.run) or as simple user.

I't is recommended to instal/l as t he makesure thath o
user has all necessary permissions to automatically build SDK projects.

9. Select to install the latest version of SEGGER J-Link GDB server and click Next.
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1zPack - Installation of SmartSnippets Studio

d dlalog User Data

Step3of9
A Renesas Company P

Select SEGGER J-Link GDB Server.

) Select path of already-installed SEGGER J-Link GDB Server
O Install recommended version of SEGGER J-Link CDB Server

J-Link Software v7.22b will be installed in user's home directory at the end of
current installation.

N
\

(Made with 1zP ack - http:/iizpack orgl)

4 Previous | | 8 Next | | @ Quit

Figure 6: Automatically Install the J-Link

10. Selectthe destinat i on f ol der for the SmaNextSni ppetsE Studi o a

Destination Folder on root installation default folder depends on Linux distribution (usually
fusrflocal ) else default folder is userds home director)

ddlalog Target Path

Step50f9

A Renesas Company

[& Select the installation path:

/home randuser/DiaSemi/SmartSnippetsStudio2.0.18| & Browse...

N
|

(Mad with 2P ack - hittpifizpack.orgl)

€= Previous | | B Next || @ Quit

Figure 7: Select Smar t Sni p p et mn&allPirectdry o
11. The application can be executed from terminal by running:
<inst_dir>/Diasemi/SmartSnippetsStudio2.0.6/CDT/SmartSnippets _Studio.startup.sh
Also, .desktop files (shortcut files) are created in the following cases:

a. For installation as root user:
Justisharelapplications/smartsnippets_studio.desktop

b. For installation as normal user:
/home/<user>/localishare/applications/smartsnippets _studio.desktop

These shortcuts should be visible from the window manager and the Desktop. Enable launching if

needed. For example, on Ubuntu 20.04 right <click on
(Figure 8).
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Open
Open With Other Application

Cut
Copy
Rename...

smartsnippets - Move to Trash
studio_2.0.14....

Allow Launching

. Properties

smartsnippets_-
toolbox 2.0.1...

Show in Files

Figure 8: Allow Launching on Ubuntu 20.04

1.3 Reinstall/Uninstall under Windows

It is recommended to uninstall the previous version
new one. Also remove any remaining files and folders if installing under the same directory path. If
not, the new version of SmartSnippetsE Studio will s

installing itself.

Smart SnippetsE Studio workspace will not be removed .
installation folder. So, workspaces can be used even after installing a newer version of the tool.

In cases there is some major change in how external paths are being treated internally, user may
have to reconfigure project paths (for example, the JLink or SDK paths) again.

In general, Eclipse workspace preferences are maintained if user prefer working under the same
wor kspace, even after upgrading to a new version of

To uninstal/]l SmartSnippet s E S tby execotingitre mnstdli ndows, you
Smart Sni pp et lecitedsnder $taro> All programs > Dialog Semiconductor folder.

Note that after the uninstallation completes, the .metadata file is not deleted so that the workspaces
that have been created inSmartSni ppet sE Studio are still available.

During uninstallation process, user can select which of the currently installed GNU ARM GCC
toolchains would like to remove.

B Uninstall Gnu Arm Gec = =

Select which GNU ARM GCC installations to remove

[v]4_9-2015g1

Figure 9: Uninstall GNU ARM GCC
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1.4 Reinstall/Uninstall under Linux

It is recommended to uninstall the previous version before reinstalling a more recent one under the
same directory. Linux installer will not try to uninstall the previous version by itself.

To uninstall SmartSnippetsE St udi o from Li nux, unnstalershormut(seee ar ch f or
Figure 10) or run:

/home/someuser/DiaSemi/'SmartSnippetsStudio2.0.14/CDT/scripts/u ninstalluninstall_start
up.sh

Q  uninstall Smart] ®

{s}

Uninstall Smart...

Figure 10: Uninstall Shortcut on Linux

This should:

0 Remove the installation files and folders (will ask first for folder)

0 Remove file /etc/profile.d/smartsnippets_studio.sh if you installed as root or lines between
DIALOGECLIPSECONF_START and DIALOGECLIPSECONF_END on your PATH settings file
(~/.bash_profile or ~/.profile) if you installed as user

0 Remove the SmartSnippets .desktop file under /usr/share/applications for root installation or

/home/<user>/.local/share/applications/ for normal user installation

O Remove fsimag tisnd ppets_studio_common_ftdi _devices.ru
/etc/udev/rules.d

~

0 Uninstaller will ask which GNU ARM GCC toolchains to remove (see Figure 9)

Smart SnippetsE Studi o workspace will  niostallaipe r emoved
folder. So, workspaces can be used even after installing a newer version of the tool.

If there is some major change in how external paths are being treated internally, user may have to
reconfigure project paths (for example, the JLink or SDK paths) again.

In general, Eclipse workspace preferences are maintained if user prefer working under the same
workspace, even after upgrading to a newer version of SmartSnippetse St udi o .
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2 Starting SmartSnippetsE Studio

By starting the SmartSnippetsE St udi othabusedwillséet er sel e.
is the welcome page. Nevertheless, the exact first time that IDE starts this might not be the actual
case since some configuration needs to take place first.

No Toolchain included

Note that no toolchain is included by default with the provided installers. This is applicable for all
platform installers. Furthermore, once a workspace gets connected with an SDK which requires a
toolchain as a dependency, then a tool called "SDK Wizard" will come forward to guide the user in
order to install the required dependencies. See Section 2.3 for more details.

2.1 Select Workspace

When SmartSnippetsE St udi o starts for the first tundee, it pron
user 6 s pr tofexample, dindelr @ \dJsers \(<user> \ workspace without SDK  for windows).

User must download and unzip an SDK to work with SmartSnippets Studio. Extract to a path that do
not contain spaces. See also Section 15.29.

The workspace must be the root directory of the downloaded and unzipped SDK. The root directory
contains folders named fisdko and A pinclodesadilelke, and a f
Aconfig. xmlod

SmartSnippetsE Studio st or esworkspace. Ugerocarjabvayschangen a f ol d.
the targeted workspace from the top menu (File > Switch workspace) or through the
Smart Sni ppet skE St udéedigwee? forpome3).Page (

Important Note: When IDE loads the workspace, it tries to locate also an SDK under the specified

path. For that reason, users should always export the root directory of the SDK they want to work

with under the selected workspace path. This ensures
the workspace will be able to read necessary configuration settings and will also prepare

appropriately the environment for this SDK.

Indiff er ent case, SmartSnippetsE Studio will willot be abl
not set up the necessary tools and configuration parameters for working under the context of an
SDK. Pl ease also note that t toebefarstPial documentati ond b

In case workspace folder does not correspond to a valid SDK root folder or corresponds to one of the
ol der SDKs supported by SmartSnippetsE Studio (namel
1.0.4 SDK), Smart Sni pp ewildhowtmasdagelikevind-lgweo2ine p a g

This means that a predefined set of tools, URLs and buttons will get by default enabled, but the
overall installation/configuration will not be necessarily compatible with what is needed for
this SDK to work appropriately under the specified workspace.

NOTE

It is better that path to workspace should not contain spaces or else some projects may have build errors.

To ensure that when the SmartSnippetsE Studio | au
in place, it reads the SDK configuration files and sets up the appropriate environment. This means that if the
user modifies some of the preferences (for example, Windows > Preferences > MCU > Global SEGGER
JLink Path) that reside in the configuration files too, next time the workspace starts these user preferences

are read again from the SDK configuration file and will get overwritten.

If for any reason (highly not recommended) the user wants to override the default configuration parameters
for an SDK, the following steps should be followed:

1. Rename the <sdk root> \config \*SDK configxml  file by adding a prefix to the filename and placing the
new file under the same folder (<sdk root> \ config ).

2. Modify the copied *SDK_config.xml file.
3. RestatSmart Sni ppetsE Studio.
The following preferences are reset every time Studio launches:
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NOTE

1. C/ C++ I ndexer: fiindex source files not included
false when Studio starts.

2. C/C++ Build: "Build configuration only when there are Eclipse resource changes..." is always set to false
when Studio starts.

2.2 Supported SDKs

From version 2.0.10 the following SDKs are supported:
SDK5: version 5.0.4 or newer

SDKG6: all versions

SDKZ1: version 1.0.6 or newer
SDK10: all versions

O« O« O¢ O«

2.3 SDK Tools Installer

When the user runs the SmartSnippetsE Studio instal]l
getting automatically installed.

Table 1: Default Tool Installation

Tool Name Version for Installation Directory

Studio v2.0.18
Doxygen 1.8.16 DiaSemi/SmartSnippetsStudio2.0.18/Tools/doxygen
mingw-w64 (windows only) | 4.3.5 DiaSemi/SmartSnippetsStudio2.0.18/Tools/mingw32
Msys2 (windows only) 20190524 DiaSemi/SmartSnippetsStudio2.0.18/Tools//msys2
Python 3.5 DiaSemi/SmartSnippetsStudio2.0.18/Python35

Depending on the selected SDK, there are some SDK dependencies that need to be installed. The
set of SDK specific tools or the required versions may differ from SDK to SDK. Also, the selected
SDK may have been tested with tool versions that are different than the ones bundled by default with
the Studio installer.

To ensure that all required tools and their appropriate versions are installed, the SDK Tools Installer
wizard is launched when Studio starts to guide the user through the installation process. A tool may
be mandatory or optional. An optional tool can be specified in the configuration xml of the SDK with
the attributec an _s ki p=0trueod

I nstall ation of optional tools can be skippeid in the
remembered by SmartSnippetsE Studio so that the wiza
this tool the next time the wizard is launched. However, if the user decides to install an optional tool

that has been skipped, a preference can be modified in order to trigger again the wizard which will

also ask again for the skipped tools.

Figure 11 shows the first page of the wizard, which presents a table of the selected tools that this
SDK requires along with the required version of the tool(s) and optionally the currently installed one
for those that they are already installed. If the required version of a tool is not matching or not found
at all, the wizard will prompt for tool installation.

Important Note: It is mandatory go through this wizard since otherwise SDK tools will not become
functional or get installed at all. For that reason, users should never exit this dialog box by clicking the
Abort all button. Instead, they should follow the steps till the Finish button appears (see Figure 15).
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SDK Tools Installer

SDK Tools Summary

Welcome to the installation of required SDK tools

The selected SDK has been tested by Dialog with the specific versions of the tools listed below under column '‘Required version for this SDK.
Please note that the required versions for a specific SDK may be different than the default versions bundled in the SmartSnippets Studio installer.
Dialog strongly recommends using the required versions; using different versions may cause unexpected side effects.

Tool Name Required version forthis 5 Installed version Found installed in path{s) Required version fou
Segger Ozone 2.56] = = =
J-Link software package components 6.14h 6.32b C:\Program Files (x86)\SEGGERULIn F 4
GMNU Tools for ARM Embedded Processo 6-2017-g2 §-2017-g2 C\DiaSemi'SmartSnippets Studio2.0. '
Systemview 252a - - k4

< Back Finish Cancel Abort all
Figure 11: The SDK Tools Installer Wizard Intro Page

For the selected SDK, installer will guide the user to install Segger JLink, Segger Ozone, and Segger
SystemView.

For tools that have been specified as optional, user can always skip those by clicking the Skip button
and eventually continue with the rest of the installation process.

User should normally install all optional tools and then click the Next button to continue with the
installation dialog, as in Figure 12.

SDK Tools Installer

Segger Ozone installation
You can skip the installation by pressing the "Skip" button

Segger Ozone version 2 561 could not be found

(O Required version is already installed
(® Download and install the required version

Download

Segger Ozone successfully installed in folder C:\Program Files (x86\SEGGER\Ozone V2.561 v

= Back Next Finish Cancel Abort all

Figure 12: Installation of Segger Ozone by the SDK Tools Installer

For mandatory tools, the user has to download and install such tools by clicking the Download
button or can always specify an installation folder if the tool is already installed externally. The Next
button is enabled only after specifying a valid installation path or successfully installing the tool.

Figure 13 showns the installation of Segger J-Link software components, which are mandatory.
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SDK Tools Installer

Segger J-Link software packag

J-Link software package components version 6.14h could not be found.

() Required version is already installed

() Install the required version

Next Finish Cancel Abartall

Figure 13: Installation of Segger J-Link Software Components by SDK Tools Installer

SDK Tools Installer

Segger SystemView installation

You can skip the installation by pressing the "Skip" button

SystemView version 2.52a could not be found

(0 Required version is already installed
(0 Download and install the required version

< Back Finish Cancel Abort all
Figure 14: Skipping Segger SystemView Installation in SDK Tools Installer

The last page of the wizard shows a summary of installed and skipped tools (Figure 15).

If the option Do not ask again for skipped tools is selected, the SDK Tools Installer wizard will not
ask again for the installation of tools that the user has selected to skip. Note that user preferences for

skipped tools are SDK specific, measelechDpndthsat user 06s

again for skipped tools, has no effect on another SDK.
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SDK Tools Installer

Summary

The following tools have been installed:
Segger Ozone
Segger J-Link software package components

The following tools have been skipped:
= Segger SystemView

Do not ask again for skipped tools.

You can modify your choice at any time by selecting Window -= Preferences -= Dialog Semiconductor -= SDK Tools Installer Wizard

< Back Skip Cancel Abort all
Figure 15: SDK Tools Installer Wizard Summary Page
As mentioned in the last page of the wizard, the user can modify the choice for the wizard to ask or
not for tools that have been skipped by the user through the preferences page.
Figure 16 shows SDK Tools Installer Wizard preferences page.

Selecting the Prompt for the installation of skipped tools checkbox and clicking Apply or OK will
trigger SDK Tools Installer wizard, which will guide the user to install tools that have been skipped in
the past.

(£} Preferences = O >
type filter test SDK Tools Installer Wizard (Sl T
G I
C?Efrf Prompt for the installation of skipped tools:

~ Dialog Semiconductar
SDK Tooels Installer Wizard
Daosygen
Help
Install/Update
Java

MCU
PyDev
ReST Editor
Run/Debug
Teamn
Terminal
Restore Defaults Apply

Figure 16: SDK Tools Installer Wizard Preference Page

Note: For tools provided by SEGGER (for example, the Ozone debugger, the J-Link software
package and the System Viewer), older versions are delivered on as-is basis and come without
support from SEGGER.

SEGGER Support can only be provided if the current version available on the SEGGER website
shows the same misbehavior as the older one that is required for running an SDK.
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2.3.1 Smart Sni ppet slistalfatom via $DK Tools Installer

Smart SnippetsE Toolbox is no | onger i rfeheableltoed by Sma
|l aunch the tool from the SmartSnippetsE Studio welco
the configuration xml file of the SDK. The SDK Tools installer wizard will guide the user on installing it

and/or making its installation path known to Studio. The following lines can be added under <tools>

nodefor windows platformt o0 make Smart SnippetsE Toolbox available

<tool id="toolbox" can_skip="true">
<name>SmartSnippets Toolbox</name>

<official_ur >https://sp - proptimality.s3.eu - west -
3.amazonaws.com/ApplicationUpdates/ToolBox/SmartSnippets_Toolbox v5.0.19.4046 windows.msi
</official_ur>
<version>5.0.19<Aersion>
<official_download_ur direct_download="no">https://sp - proptimality.s3.eu - west -

3. amazonaws.com/ApplicationUpdates/ToolBox/SmartSnippets_Toolbox v5.0.19.4046 windows.msi
</official_download_ur>

<ftoob>

The wizard will ask from the user to configure the installation path of Toolbox. The user can

downl oad and instal/l Smart SnippetsE Tool box installe
installer wizard page. I f  Smar t, Beuse qaedirectty brows® | box i s
and select the path where Smart SnippetsE Tool box i s |

has been added as an optional dependency in the configuration xml file (can_skip  attribute is true). If

the tool installation is skipped or the SDK Tools Installer wizard dialog box is closed before installing

Smart SnippetsE Tool box, SmartSnippetsE Toolbox and R
the welcome page, even if they are enabled in the configuration xm file.

SDK Tools Installer

SmartSnippets Toolbox installation

You can skip the installation by pressing the "Skip" button

SmanSnippets Toolbox version 5.0.19 could not be found. Ifthis version is already installed, please specify the installation folder below. Otherwise download it from the
following url, run the installer and then specify the installation folder.

SmartSnippets Toolbox 5.0.19

Flease specify the installation folder:

Browse

= Back Finish Cancel Abort all

Figure17: Smart Sni pp e Pag&in SOKdTbotbsdnstaller
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SDK Tools Installer

SmartSnippets Toolbox installation

You can skip the installation by pressing the "Skip" button

SmanSnippets Toolbox version 5.0.19 could not be found. Ifthis version is already installed, please specify the installation folder below. Otherwise download it from the
following url, run the installer and then specify the installation folder.

SmartSnippets Toolbox 5.0.19

Flease specify the installation folder:

C\Program Files\SmanSnippetsToolboxiSmartSnippetsToolbox5.0.19 || Browse | \/
= Back Mext Finish Cancel Abort all
Figure 18: I nstallation path of S/erdiedtb3DKJgoksinstélerTool box i

2.4 Change Workspace Toolchain

By default, toolchain is being set up by the SDK Tools Installer Wizard as described in
Section 2.3.User may change the global or workspace toolchain from menu item Window >
Preferences > MCU as shown in Figure 19.

@ Preferences - 0 x
type filter text Workspace ARM Toolchains Paths (g T
General

Configure the locations where various GNU ARM toolchains are installed. The paths are stored in the workspace and
override the global paths. Unless redefined per project, they are used for all projects in this workspace,

Default teolchain: | GMU Tools for ARM Embedded Processors ~

C/C++

Dialog Semiconductor

Doxygen

Help Toolchain name:  |GMU Tools for ARM Embedded Processors

Install/Update

Java

~ MCU

Global ARM Toolchains Paths
Global Build Tools Path
Global SEGGER J-Link Path
Workspace ARM Toolchains Paths
Workspace Build Tools Path
Waorkspace SEGGER J-Link Path

PyDev

ReST Editor

Run/Debug

Toolchain folder: | C:\DiaSemit\SmartSnippetsStudio2 0.64GCC\6-2017-g2\bin Browse... xPack...

Team
Terminal

Restore Defaults Apply

@' Cancel
Figure 19: Change Global or Workspace Toolchain

Note that after a Studio restart or a workspace change, the toolchain location path reverts to its default
version as defined in SDK configuration and setup by SDK Tools Installer Wizard.

User may also change the toolchain for a specific project by right-clicking on project and selecting
Properties > MCU > Arm Toolchains Paths as shown in Figure 20.
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0 Properties for ble_adw

type filter text

Resource

Builders

C/C++ Build

w C/C++ General
Code Analysis
Documentation

v

W

v

File Types
Formatter
Indexer
Language Mappings
Paths and Symbaols
Prepracessor Include Pz
~ MCU
ARM Toolchains Paths
Build Tools Path
SEGGER J-Link Path
Project References
Run/Debug Settings

m] x

ARM Toolchains Paths o - - -

=

Configure the location where various GNU ARM toolchains are installed. The values are stored in the workspace (not
in the project). They are used for all build configurations of this project, and override the workspace or global paths.
Toolchain name: |GNU Tools for ARM Embedded Processors

Teolchain folder: | | Browse... xPack...

Restore Defaults Apply

Figure 20: Change Project Toolchain

In such a case user's selection remains after Studio restarts.
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3 Welcome Page

The welcome page provides the user with the ability for easily launching applications, configure the
SmartSnippets SDKs and HDKs (Hardware Development Kits), browse documentation and examples
among other useful links.

The welcome page displayed in Figure 22 and Figure 23 can be reopened at any time via different
accessing points, see points 1 and 2 recognizable as () respectfully.

Additionally, the welcome page presents a dynamic set of tools and URLs directly associated with
the linked SDK. Depending on SDK selected slightly different options may be available gn the
welcome page.

Important Note: In case the selected workspace does not correspond to a valid SDK, a warning
message is displayed on the welcome page prompting user to take some actions. User can either
run the SDK finder tool to search for a valid SDK in local computer. (Figure 21). The user can dismiss
it using the [x] button.

Warning: This workspace does not contain a valid SDK.

Please do the following:

a) Press the "SDK Finder" button, that will display a list of valid SDKs, found under
the selected directory Watch the progress on the lower right corner.

Search for SDKs in C:\tmp: (0%) =

Or b) Press SmartSnippets Toolbox, to use the toolbox without any SDK

Figure 21: No SDK Selected Error in Welcome Page
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Figure 22: SDK Welcome Page
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Figure 23: More Options on SDK Welcome Page

The functionality of the welcome page is described with more details in the following sections.

3.1 Provided Configurations

SDK Root directory selection (Figure 22 point 3): User can configure from here the root path for
the SDK/Workspace that would like to use.

When change in the above path iwilltaskaserufiieaktogSfanar t Sni pp
restart so it can switch to the new workspace. If user selects to cancel from the Switch Workspace
dialog box, the SDK root path will not change.

Switch Workspace “

Workspace switch is required because a different SmartSnippets SDE
reot has been selected,

Do you want to restart your IDE in order to switch workspace?
Pressing cancel will not change SmartSnippets 5DK root path.

| OK | | Cancel

Figure 24: Switch Workspace Verification
In case that user is not using the latest SDK per chip family, an appropriate message is getting
prompted, so to let the user know that he can go and download the latest one.
User can download the latest SDK by clicking the Download link (Figure 22 point 4).
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SDK finder (Figure 23 point 19): SDK finder is a tool that searches on the local computer for valid
SDKs. User select the startup directory (Figure 25) and a background process starts searching
(Figure 26). When finished, results are presented in a table (Figure 27). If the Use this SDK button is
clicked, the switch workspace verification is shown (Figure 24) and the new SDK is used after restart.

Select the directory under which the tool will search for SDKs. SDK finder will recognize
SDK 5.0.4 and newer, 5Dk 1.0.6 and newer, all versions of SDK &, and all versions of
SDK 10.

B Desktop 2
> i% Homegroup
> & admin
4 M This PC
> g Desktop
> | Documents
[0 Domioss]
W Music
» = Pictures
> | @ Videos
iy Windows8_05 (C)
» a LENOVO (D)
> ) DVD RW Drive (E2) o

Folder: Downloads

Make Mew Folder Cancel

Figure 25: SDK Finder Select Root Directory to Search

- Search for SDKs in C:\tmp\SDK: (0%) . =

Figure 26: SDK Finder Active Search Indicator

The following 5DKz have been found under Ch\tmphSDK.
Select SDK to use:

50K Path

Citmpt SDENSDK 5.0.40DA1458x_SDKA3.04
Citmph SDENSDK_10.0.4.66
Citmph SDKOSDK_B.0.11.96545DKM6.0.11.965

Use this SDK

Figure 27: SDK Finder Results

Note: Tool process time depends on filesystem tree of the selected root search folder.

Family selection (Figure 23 point 20): If SKD supports more than one product family, user can
select the family to wor k wconhfiguratiohhi we lopdme npdgddadsr
resources section, device selection as well as the results on some tools such as SDK Inspector.

Device selection (Figure 22 point 5): User can select the connected device from a list of supported
devices.

For DA1468x SDKs, user can see a list of part numbers and matching devices displayed in (Figure
28) by clickingt h e fi h eFigaré 22IpoinhR. (
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(121 Part number info “

Part number / erdering number Device

: DA14680-00F08AS1 DA14630-00
DA14620-00F08A92 DA14620-00
DA14681-00000A91 DA14681-00
DA14681-00000U22 DA14681-00
DA14621-00000492 DA14681-00
DA14680-01F18AS1 DA14680-01
DA14680-01F08A%2 DA14680-01
DA14681-01000491 DA14681-01
DA14681-01000U22 DA14681-01
DA14681-01000A92 DA14681-01
DA14681-01A9DEVKT-B DA14681-01
DA14681-01A9DEVKT-P DA14681-01
DA14681-01U2DB-P DA14681-01
DA14681-01A9DB-P DA14681-01

Figure 28: Part Number Info Dialog Box
In cases that user is not aware about the selected hardware, there is always the option to detect the
connected devices by clicking the Detect connected devices(s) button (Figure 22 point 6).

A notification message will appear on the top right side of the welcome page, informing the user
about the currently detected devices.

3.2 Notifications

In Figure 22, point 8 presents a notification that indicates a wrong configuration in Segger tools. User
is advised to manually correct the error according t

The notification is automatically dismissed when user corrects the error or can be closed by clicking
the * button.

3.3 Listed Tools

Welcome screen contains a list of shortcuts to Tools so that the user can easily launch other

applications from within SmartSnippetsE Studio.
IDE: (Figure 22 point 9): Switches to the IDE workbench in the C/C++ perspective.

SmartSnippets Toolbox: (Figure 22 point 10): Launches SmartSnippets Toolbox as an external
application.

Ozone Debugger: (Figure 22 point 11): Opens SEGGER Ozone (JLink Debugger) as an external
application. The path where user installed Ozone is set through Window > Preferences > Run/Debug
> SEGGER Ozone.

System View: (Figure 22 point 12): Opens System View tool as an external application.

Keil IDE: (Figure 22 point 13): Bpens Keil IDE as an external application instead of C/C++
perspective inside the IDE. Note that for DA14580/581/583 SDKs, C/C++ perspective is not
available.
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IAR Embedded workbench (Figure 23 point 22): Opens IAR Embedded workbench as an external
application.

SDK inspector (Figure 23 point 21): Scans SDK root folder for projects. The following platforms are
currently supported: Eclipse CDT projects and uVision Keil. Also shows new user projects created

with Studio.
If tool is enabled by the SDK the icon is shown on the welcome page as in Figure 29.

SDK Inspectar
Figure 29: SDK Inspector Icon

Scan process starts when opening application. A spinning icon and empty table indicate that process
is still running (Figure 30).

® SDK inspector H
5dk scanning. Please wait ... 3
Product Family: DA1469x
Project Name Product Families Type IDE

View project details | Export data Close

Figure 30: SDK Inspector Scan Process

When done, projects are shown on the table (Figure 31). Projects are filtered based on Product
Family selection of the welcome screen. This filter is shown on top of the table.
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[1:1] SDK inspector
Projects found: 34
Product Family: DA145853-586
Project Nam:.a Product Families Type IDE 2
aes DA14585-586 ulision
ancs_client DA14585-586 uVision
batt_lvl DA1453x DA14585-586 ulision
ble_app_all_in_one DA14585-586 uVision
ble_app_barebone DA1433x DAT4585-586 uVision
ble_app_noncon DA14585-586 uVision
ble_app_ota DA14585-586 uVision
hle ann nerinheral MA1453% NATA585-58A/ ulizinn w7

€

View project details | | Export data

Close

Project table has the following columns:

O« O«

Project name

patterns i
of such pattern is for example:

<studio_config>
<sdk_search>

n

SDKd&s

<Eclipse id=".cproject">
<family id="DA1468x">name="(*)DA1468[0123]

<family id="DA14585

<family
</Eclipse>

<uVision id=".uvprojx">

<family id="DA14585
<family id="DA14585

</uVision>
</sdk_search>

Wheren ame méans

t o

search

X ml

for

Figure 31: SDK Inspector Project Table

file i

- 0[0L)(*)'<framily>

- 586">name="(*)DA1458[56](*)'<ffamily>
id="DA1468X >fle="startup_DA1468xs'</family>

- 586">name="(*)_58[56]'<ffamily>
- 586'">fle="startup DA14585 586."</family>

projectbés

n

Product families. SDK inspector tries to find the supported families for a project using search
config.

combi

bui l

pattern. If match assign this project to corresponding family id. A project may support more
than one product families.

Pattern f i
pattern.

| me@dms t o

sear ch

d

nati on

conf

n pr afiles that hach thegvenn d ency f

This is a best effort process. If no product family found, the table field is blank.

0 Type. Applies only for Eclipse project. Two values are possible. Native and embedded.

O IDE. Either Eclipse or uVision.

The Export data button exports table contents in comma-separated text .csv format.
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User can have access to project details with one of the following ways:

0 Select project from the table and press the View project details button
0 Right click on project row and click details on the context menu
0 Double click on project row

Figure 32 shows an example of a project details view for an Eclipse type project.

Name prox_reporter
Full path: CAtmp\SDK\DA14585_5DKNG.0.11.925\projects\target_apps\ble_examples\prox_reporter\Eclipse

Open in file explorer | | Openin IDE

Product Families: DA1453x DA14585-586

Devices: DA14531-00
DA14331-01
DA14585-00
DA14586-00
Type: Embedded
IDE: Eclipse
Toolchains: GMNU Tools for ARM Embedded Processors[C:\DiaSemi\SmartSnippetsStudio2.0.9\GCC\7-2018g2\bin]
Build configurations: DA14531
DA14385
DA14386

Figure 32: SDK Inspector Project Details of Eclipse Project

The new information here is:

(@]

Ful | pat h. User may open full path in systembs fil e
Product Families: Product families found to be supported by this project

Devices. Just present the devices supported by the product families found. If no product families
are found, this field is blank

Toolchain. Applies for Eclipse projects only (Figure 32). If project have already imported into the
workspace the toolchain name and path (only for Cross ARM GCC) is shown here. Toolchain is
searched with respect to the hierarchy project settings-workspace settings-global settings

O« O«

0 If project is not imported into the workspace then, workspace default values or values taken from
projectds configuration is shown

O Build configurations. Here shown all projectds buil
plus those configurations that could not match to a product family

0 Open in IDE button. When clicked, a table with all available build configurations are shown
(Figure 33)

MNarme Description
DA14531
DA14585
DA14586

Close

Figure 33: Select Build Configuration to Open
User selects the preferred build configuration. When the confirmation message is accepted (Figure

34) SDK inspector closes and project with the selected build configuration is opened at IDE (Figure
35).
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Open project prox_reporter in Eclipse 7

Figure 34: SDK Inspector. Confirm Open Project in IDE

File Edit Source Refactor Mavigate Search  Project Run Window Help
NrHO S R-BIEIN| SR a €@
® [P Project Expl::urer 1DA14331 = = 0
2 DA14585

s 8 host_suotai

+ 5 mkimage 3 DA14586

+ 5 moniter

. 5 prodtest

o= prox_reporter

= reporter

Figure 35: SDK Inspector Selected Project and Build Configuration

3.4 Resources

API Documentation: (Figure 22 point14): Opens t he Di al cDKD®aumentatom duct or 6 s
located inside doc/html folder of the SDK. To work correctly, the location of a proper SDK should be
given in point 3.

Software Resources: (Figure 22 point 15): Opens a dialog to the SDK root directory structure. After

selecting a directory, the available projects are shown. The selected projects are imported in the

wor kspace and SmartSnippetsE St u#Higue3Gshowsanhes to C/ C+
example of using Software Examples of welcome page to import projects from the SDK into the

workspace. Import of software resources is not available for DA14580/581/583 SDKs.
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1)

Import

Import Projects

Select a directory to search for existing Eclipse projects.

(®) Select root directory:

() Select archive file:

Projects:

Ch\Black_Orca_SDK_BTLE v_1.0.4_Beta_GA_R w

<

ancs (ChBlack_Orca_S0K_BTLE_v_1.0.4_Beta_GA_RC1.653\proje »~
ble_adv (C:h\Black_Orca_SDE_BTLE_v_1.0.4_Beta_GA_RC1.655\p1
ble_central (C\Black_Orca SDK_BTLE w_1.0.4 Beta_GA_RC1.632
ble_external_host (Ch\Black_Crca_SDE_BTLE v_1.0.4_Beta_GA_R
ble_multi_link (CA\Black_Orca_SDK_BTLE wv_1.0.4 Beta_GA_RC1.
ble_peripheral (C\Black_Orca_SDE_BTLE v_1.0.4_Beta GA_RCT.
brms (ChBlack_Orca_SDE_BTLE v_1.0.4_Beta_GA_RC1.655\proje
deepsleep (C\Black_Orca_SDK_BTLE v_1.0.4_Beta_GA_RC1.655" -

>

Options
[[]Search for nested projects

[l Copy projects into workspace

[ Hide projects that already exist in the workspace

Working sets

[[] Add project te working sets

@

< Back Mext = Einish

Browse...

Select All
Deselect All

Fefresh

Cancel

Figure 36: Import a Project

Product documentation: (Figure 22 point 16): Hereby you can find a collection of links to portals or
directories containing product documentation.

Forums (Figure22poi nt 17): Hereby you

forums.

c

an

f

ind a col

Find Your Partner (Figure 22 point 18): Collection of links to SmartBond Partner Ecosystem.

To get access to the repositories under points 15, 16, and 17 visible in Figure 22 the user must

register for an account.

3.5 SDKs for More than One Family

When SDK which supports more than one family is loaded for first time, configuration and information
for all supported families is presented on the welcome page. The user can select one of the available
families from the respective drop-down box. Then devices, tools, and resources of the selected
family are presented only. The family selected by the user is saved in the workspace and the next
time the same SDK is used, the configuration of the last selected family will be presented. Available
build and debug configurations (if any), are also filtered by family and by device. When no specific
device has been selected, all the build and debug configurations of the selected family are available.
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@ Welcome 23] = 8
SmartSnippets™ Studio
SELECT YOUR SDK ROOT DIRECTORY HERE
|C \Users\artpap\Documents\Dialog_SDKs\multiple_families\680_6¢
SELECT YOUR PRODUCT FAMILY
A4
SELECT THE DEVICE ON YOUR DEVELOPMENT BOARD
Don't know your device number? Click here for more
information.
Segger Ozone
Battery Profiler Keil IDE
API DOCUMENTATION SOFTWARE RESOURCES PRODUCT DOCUMENTATION FORUMS
Import test projects in workspace DA14680 SmartBond Forums
DA14681
Figure 37: No Family Selected
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4  SmartBond Projects

Di al ogbs Smart BondE family is the s-frienglyaadflexibleout e t o
Bluetooth® Smart connected products to the market.

See http://www.dialog-semiconductor.com/bluetooth-smart for more details.

In the following chapters, we providepr oj ect exampl es based on SDKo6s supp
and tools.

4.1 Build a Simple Application in Keil

This section explains how the user can select, build, and run a simple software application on a
development board using KEIL IDE.

Furthermore, it provides step-by-step instructions for setting up one of the example projects, build
and eventually execute it via the debug mode in any of the supported devices. However, for the
needs of this demonstration we will use a DA14585/586 device and for that reason we need to
choose the appropriate SDK as well.

For more information regarding KEIL Environment, visit Keil Website.

Blinky is a simple application which demonstrates basic device initialization and LED blinking
functionality.

Once SDK is successfully unzipped, blinky-example source code can be found under the directory
beripheral exampl esbd

To get started, go through the following steps:

1. Open the folder containing the SDK files. This is the folder where you extracted the SDK zip file.
2. In <sdk root_directory> \ projects  \target apps \ peripheral examples \ blinky \Keil \ 5,
double-click blinky.uvproj to open the project in Keil.

4| This_is_Your_Sdk_Root_Directory
> binaries
config
doc
4 | projects
host_apps
4 target_apps
ble_examples
hci
| misc
4 | peripheral_examples
| adc
4 | blnky
include
Kei_5
src

b i2c
quadrature_decoder
shared

I spi
| systick

Figure 38: Blinky Project Directory

The development environment should look like in Figure 39 when the project is opened with Keil.
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File Edit View Project Flash Debug Peripherals Tools

Ed
e

Project

= N .Y
2=~ | 5% sunky

@

=% Project: blinky
B %3 BLINKY
@3 poot
@3 driver
@3 common_uart
=& app
@1 mainc
@ user _periph_setu|

U

SVCS Window Help

| | Bl m| ==

_ Jxlezeve

\j main.c
41 void blinky test(void);
42
43 H/**
44 EXEXEEXXEEXEXEEXXEEAEXEXEE XX X XX
45 * @brief Main routine of the !
46 | *
4'7 EXEXEEELXEL X AT T XA XA XXX XXX
48 L x/
49 int main (void)
501
51 system init();
52 periph init();
53 blinky test();
54 while (1)
5511 }
56 -
578/*%
sAQ tdeedisndiasdissdiasdiaedi s by

Figure 39: Blinky Project Keil Workspace

3. Click the Target Options button, then click the Device tab. The dialog box should look like

Figure 40.

Figure 40: Blinky Project Options

4. Then click the Linker tab. Scatter files (.sct ) are used for selecting memory areas.
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